
Thank you for buying B's Recorder GOLD5. This guide explains the functions unique to each CD-R/
RW, DVD-R/RW/RAM/+RW/+R drive and the options in [Advanced Drive Settings]. The list of 
supported drives is constantly being updated. Refer to the drive's manual and this drive guide to learn 
more about each drive's unique functions.
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DVD-RW ND1300M

The model number shown on the drive you are using may not be listed in this document, but if the 
internal drive model number listed in the Device Manager is listed in this document, the drive is 
supported by B’s Recorder GOLD5. Follow the procedure below to check the drive model number in the 
Device Manager..

Windows 98/98 SE/Me Users
Open [Start] → [Settings] → [Control Panel] → [System]. Select the [Device Manager] tab, then open 
[CD-ROM].

Windows 2000/XP Users
Open [Start] → [Control Panel] → [System]. Click [Device Manager] under the [Hardware] tab, then 
open [DVD/CD-ROM drives].

1 Checking Drive Support

Note Even though the drive you are using is supported by B’s Recorder GOLD5, it may not 
operate properly if it is connected using an ATAPI to USB, SCSI or IEEE 1394 converter. 
Consult the drive maker for more details about converters.
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Window Modifications
• The [Advanced Drive Settings] button is now located next to the [Drive in use] setting. See 1 below.
• The [Eject after recorded] option was added at the bottom of the window. See 2 below.

If this option is disabled, the disc will not eject until you click the [OK] button. This applies to the last 
disc when recording multiple copies.

2 Advanced Drive Settings

1

2

2



SmoothLink Function

SmoothLink Function

❖ Avoid Transmission Speed Errors
Enable this option to use the SmoothLink function.

❖ Show transmission errors after recording
Enable this option to show the number of transmis-
sion errors after recording is complete.

❖ Play audio track while recording
Enable this option to listen to WAV and AIFF files 
while they are being recorded using the SmoothLink 
function.

❖ History
Shows the date and time of the latest transmission 
speed error, and the total number of transmission 
speed errors that have occurred to date.

Supported Drives (as at January 2003)

MATSHITA: UJDA720, UJDA730, UJDA740, CDRCB02

❖ Avoid Transmission Speed Errors
Enable this option to use the SmoothLink function.

❖ Show transmission errors after recording
Enable this option to show the number of transmis-
sion errors after recording is complete.

❖ History
Shows the date and time of the latest transmission 
speed error, and the total number of transmission 
speed errors that have occurred to date.

Supported Drives (as at January 2003)

MATSHITA: SW-9571, SW-9581, SW-9581N, LF-D521, 
UJ-810, UJ-811, DVD-RAM UJ-811, UJ-
815, DVD-RAM LF-P567

GENERIC: DVD-RAM MLT01
SAMSUNG: DVD-MULTI SRT03B
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BURN-Proof Function

BURN-Proof Function (Error Count Display)

❖ Avoid Transmission Speed Errors
Enable this option to use the BURN-Proof function.

Supported Drives (as at January 2003)

SANYO: CRD-BP2, CRD-BP3, CRD-BP900
PLEXTOR: PX-W1210S, PX-W1210A, PX-W1610A

PX-S88T, PX-W2410A
TEAC: CD-W512S, CD-W512EB, CD-W516EB, CD-W516EC

CD-W524E, CD-W540E
SONY: CRX1611
IOMEGA: ZIPCD3840INT-A
LITE-ON: LTR-12101B
TDK: CDRW161040X
HP: CD-Writer cd12d, CD-Writer cd24p

❖ Avoid Transmission Speed Errors
Enable this option to use the Burn-Proof function.

❖ Show transmission errors after recording
Enable this option to show the number of transmis-
sion errors after recording is complete.

❖ History
Shows the date and time of the latest transmission 
speed error, and the total number of transmission 
speed errors that have occurred to date.

Supported Drives (as at January 2003)

SANYO: CRD-BP1300, CRD-BP1400, CRD-BP1500 
CRD-BP4, CRD-BP5, CRD-BP1500U
CRD-SBP15A, CRD-BP1600, CRD-BP1700, 
CRD-BP1700U, CRD-BP1800P

IOMEGA: CDRW9600INT
TDK: CDRW241040X, CDRW321040X, 

CDRW401240X, CDRW401248UEX
LACIE: CDBP-241040A, CDBP-321040A, CDBP-

401240A
WAITEC: MEGALUS, STORM32, STORM40
QPS: CRD-BP1500P, QPSCRD-BP1600P, CRD-

BPO1700P
GENERIC: FREECOM32A, 
PHILIPS: CDRW3210S, CDRW3212S, CDRW48P, 

CDRW4012P
R-QUEST: TRUECOPY40A
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JustLink Function

Supported Drives (as at January 2003)

RICOH: MP7125A / RW7125A, MP9120 / RW9120, MP7200A / RW7200A, MP7163A / RW7163A
MP9200 / RW9200, MP5120 / RW5120, MP5125 / RW5125, MP7320A / RW7320A, 
MP7400A / RW7400A

HP: DVD Writer 100j, DVD Writer 200j, CD-Writer cd12n, CD-Writer cd16n, DVD Writer 300n
MATSHITA: UJDA340, CDRRW05, UJDD410, CDRRW09, UJDA360, CDRRW10, UJDD420
TEAC: CD-W28E, DW-28E, CD-W216E, CD-W224EA, DW-224E
NEC: NR-7700A, NR-8500A, NR-7800A, NR-7800B, NR-7900A, NR-9100A, NR-9200A,

DVD_RW ND-1200A, DVD_RW ND-1300A, DVD+RW ND-1000A, DVD+RW ND-1100A,
DVD-RW ND-1300M, NR-9300A, NR-9300A_S

AOpen: CD-RW CRW1232 A/PRO, 12X10X32 CD-RW A/P, CD-RW CRW1632, 16X10X32 CD-RW
CD-RW CRW2040, 20X10X40 CD-RW, CD-RW CRW2440, 24X10X40 CD-RW, CRW3248
DVRW2412PRO, 2.4X2.4X8 121032, 40X12X50 CD-RW, CD-RW CRW4050,
48X12X50 CD-RW, CD-RW CRW4850, 48X24X52 CD-RW, CD-RW4852, 52x24x52 CD-RW, 
CD-RW CRW5224

PHILIPS: DVD+RW-D01, DVD+RW-D02, DVDRW1208, DVDRW228, DVD6001, DVD6002, 
DVD+RW-D28 CDRW2010

Memorex: TwelveMAXX 1032A/P, DVD+R/RW 2.4X8AA
IODATA: CRWD-RX20J
SONY: CRX175E2, DRU-120A
CYQVE: CQ7125, CQ1232
SAMSUNG: SW-216B, SW-240B
IDE-DVD: DVDRW6001, DVDRW6002
IBM: CDRW-USB2
TDK: CDRW121032A, CDRW8824T, DVDRW0400N, DVDRW420N, CDRW482448AID
Actima: CD-RW CRW4012A
PLEXTOR: PX-S2410T, DVDR PX504A
RIDATA: DVD+RW/+R DRIVE, DVD+RW DRIVE

❖ Avoid Transmission Speed Errors
Enable this option to use the JustLink function.

❖ Show transmission errors after recording
Enable this option to show the number of transmis-
sion errors after recording is complete.

❖ Play audio track while recording
Enable this option to listen to WAV and AIFF files 
while they are being recorded using the JustLink func-
tion.

❖ History
Shows the date and time of the latest transmission 
speed error, and the total number of transmission 
speed errors that have occurred to date.
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JustSpeed Function

Optimum Write Speed Control Function

❖ JustSpeed (Optimum Write Speed Control 
Function)
Enable this option to use the JustSpeed function. The 
recording quality may be reduced when disabling this 
function depending on the CD-R disc you are using.

Supported Drives (as at January 2003)

RICOH: MP7200A / RW7200A, MP7163A / RW7163A, 
MP9200 / RW9200, MP7320A / RW7320A
MP7400A / RW7400A

AOpen: CD-RW CRW2040, 20X10X40 CD-RW, CD-
RW CRW3248, 40X12X50 CD-RW, CD-RW 
CRW4050, 48X12X50 CD-RW, CD-RW 
CRW4850, 48X24X52 CD-RW, CD-RW4852, 
52x24x52 CD-RW, CD-RW CRW5224

IODATA: CRWD-RX20J
MATSHITA: UJDD410
SONY: CRX175E2, CRX195E4
PHILIPS: CDRW2010

❖ Optimum Write Speed Control Function
By enabling this option, the drive will automatically 
select a suitable recording speed if the speed you 
have selected is unsuitable for the disc you are using.

Supported Drives (as at January 2003)

YAMAHA: CRW2100E, CRW2100S
CRW2200E, CRW2200S
CRW-70
CRW3200E, CRW3200S
CRW-F1E, CRW-F1S
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Buffer Underrun Prevention Function

Buffer Underrun Prevention Function

❖ Avoid Transmission Speed Errors
Enable this option to use the buffer underrun preven-
tion function.

❖ Show transmission errors after recording
Enable this option to show the number of transmis-
sion errors after recording is complete.

❖ Play audio track while recording
Enable this option to listen to WAV and AIFF files 
while they are being recorded using the buffer under-
run prevention function.

❖ History
Shows the date and time of the latest transmission 
speed error, and the total number of transmission 
speed errors that have occurred to date.

Supported Drives (as at January 2003)

YAMAHA: CRW2200E, CRW2200S
CRW-70
CRW3200E, CRW3200S
CRW-F1E, CRW-F1S

❖ Avoid Transmission Speed Errors
Enable this option to use the buffer underrun preven-
tion function.

Supported Drives (as at January 2003)

TOSHIBA: SD-R1102 (models with this function), SD-R2102,
SD-R1202, SR-C8002, SD-C8102, 
SDR1202F, SDR1202N, SD-R2212,
SD-R2312, SD-R5002, SD-R2412,
SD-R1312

IDE-CD: R/RW 12x8, R/RW 12x8x32, R/RW 12x10
PHILIPS: CDD4851 CD-R/RW, CDD5101, 

CDRWDVD1610, CDRWDVD1612, 
PCRW1208, PCRW1208JR, PCWR1208MR,  
PCRW1208UE

COMBI: RW16x8/DVD, RW16x10/DVD, RW16x12/DVD
PIONEER: DCR-111, DVR-104, DVR-105, DVR-K11
LITE-ON: LTR-16102B
MATSHITA: CW8572
TEAC: DV-W50E, CD-W548E, CD-W522E
HP: CD-Writer cd16r
HL-DT-ST: GCC-4240N
WAITEC: SAURUS, SFINX16
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Buffer Underrun Prevention Function (Error Count Display)

Buffer Underrun Prevention Function

❖ Avoid Transmission Speed Errors
Enable this option to use the buffer underrun preven-
tion function.

❖ Show transmission errors after recording
Enable this option to show the number of transmis-
sion errors after recording is complete.

❖ Play audio track while recording
Enable this option to listen to WAV and AIFF files 
while they are being recorded using the buffer under-
run prevention function.

❖ History
Shows the date and time of the latest transmission 
speed error, and the total number of transmission 
speed errors that have occurred to date.

Supported Drives (as at January 2003)

NEC: CB-2100A
SONY: CRX195E4

❖ Avoid Transmission Speed Errors
Enable this option to use the buffer underrun preven-
tion function.

Note: This function is effective when recording DVD-
R/RW discs only.

Supported Drives (as at January 2003)

Pioneer: DVD-RW DVR-103
MATSHITA: LF-D310, SW-9501
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Buffer Underrun Prevention Function & VariRec Functions

Power-Burn Function

❖ Avoid Transmission Speed Errors
Enable this option to use the BURN-Proof function.

❖ VariRec Mode
When you enable this option with CD-R discs, you 
can control the strength of the laser when recording in 
increments of two using the slide bar. This function 
can adjust the recording quality so it is comparable 
with that of an audio CD player. The recording speed 
will be 4x or slower.

Supported Drives (as at January 2003)

PLEXTOR: PX-W4012A, PX-W4824A, PX-W320A,
PX-W4012S

❖ Avoid Transmission Speed Errors
Enable this option to use the Power-Burn function.

❖ Show transmission errors after recording
Enable this option to show the number of transmis-
sion errors after recording is complete.

❖ History
Shows the date and time of the latest transmission 
speed error, and the total number of transmission 
speed errors that have occurred to date.

Supported Drives (as at January 2003)

SONY: CRX175A, CRX85A, CRX810E, CRX820E, 
CRXP-90MU, MPD-AP20U
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ExacLink Function

Drive Power Management

❖ Avoid Transmission Speed Errors
Enable this option to use the ExacLink function.

Supported Drives (as at January 2003)

MITSUMI: CR-48X8TE, CR-4808TE, CR-48X9TE
CR-48XATE, CR-48XCTE

PHILIPS: 16840 CDRW, 241240 CDRW, 321240 CDRW
401240 CDRW, 401248 CDRW

QSI: SBW-081, SBW-161, SBW-241

❖ Drive Power Information
When using the MPD-AP20U drive, the tab shown on 
the left can be displayed by opening the Advanced 
Drive Settings window to check the drive battery infor-
mation.
• Power source (AC or battery)
• The estimated operation time per function (in min-

utes) and remaining charge (percentage) when 
using a battery.

The information displayed in this tab is current at the 
moment you displayed the tab. Click [Refresh Infor-
mation] to update the information.

Supported Drives (as at January 2003)

SONY: MPD-AP20U
10



DVD+RW Drives

DVD+RW/+R Drives

❖ Emphasize the reading compatibility
Enable this option to improve the disc's compatibility 
with DVD-ROM drives and DVD players.

❖ Forced Format
Click this button to force format a DVD+RW disc.

Note: The contents of the entire disc will be erased.

Jumps to the DVD+RW Alliance website.

Supported Drives (as at January 2003)

RICOH: DVD+RW MP5120/DVD+RW RW5120
HP: DVD Writer 100j
PHILIPS: DVD+RW-D01, DVDW1208, DVD6001
RIDATA: DVD+RW DRIVE
IDE-DVD: DVDRW6001

❖ Emphasize the reading compatibility
Enable this option to improve the disc's compatibility 
with DVD-ROM drives and DVD players.

❖ Forced Format
Click this button to force format a DVD+RW disc.

Note: The contents of the entire disc will be erased.

Jumps to the DVD+RW Alliance website.

Supported Drives (as at January 2003)

RICOH: DVD+RW MP5125/DVD+RW RW5125
HP: DVD Writer 200j, DVD Writer 300n
SONY: DVD+RW DRU-120A, DRU-500A, DW-U10A, 

DW-U12A
RIDATA: DVD+RW/+R DRIVE 
AOpen: DVRW2412PRO, 2.4X2.4X8 121032
PHILIPS: DVDRW228, DVD+RW-D02, DVD6002, 

DVD+RW-D28
IDE-DVD: DVDRW6002
Memorex: DVD+R/RW 2.4X8AA
NEC: DVD_RW ND-1200A, DVD_RW ND-1300A, 

DVD+RW ND-1000A, DVD+RW ND-1100A
TDK: DVDRW420N, DVDRW0400N
PLEXTOR: DVDR PX-504A
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DVD-RAM Drives

❖ Physical Format
This option physically formats the disc. You will lose 
all the data on the disc when you physically format it.

A disc recorded with B's Recorder GOLD5 must be 
physically formatted before being recorded onto using 
other software.

Supported Drives (as at January 2003)

MATSHITA: SW-9571, SW-9581, SW-9581N, LF-D521
LF-D310, UJ-810, DVD-RAM UJ-811, UJ-
815, DVD-RAM LF-P567

GENERIC: DVD-RAM MLT01
HL_DT_ST: GMA-4020B
SAMSUNG: DVD-MULTI SRT03B
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DVD-RAM Drive Verification Function

a) DVD-RAM Drives with Verification option

❖ Verification
Enable this option to use the automatic substitute 
sector function. Disable this option to record only.

DVD-RAM drives incorporate extensive defect man-
agement for DVD-RAM discs. This function realizes 
high-quality recording by verifying each sector while 
recording data. If a defect sector is found, the data is 
automatically assigned to a substitute sector. Some 
drives allow you to disable this function.

Supported Drives (as at January 2003)

MATSHITA: SW-9571, SW-9581, SW-9581N, LF-D521,
LF-D310

SAMSUNG: DVD-MULTI SRT03B

Note Recording errors may occur due to fingerprints, dirt and scratches on the recording sur-
face. If you do not enable the [Verification] option, it is recommended you physically format 
the disc. Select [Disc] → [Erase] from the menu, or [Drive Settings] → [Advanced Drive 
Settings] → [Physical Format] on the Options window.

b) DVD-RAM Drives without Verification option

The window on the left appears when you are using a 
drive that does not support disabling the Verification 
option, or when a B's Recorder GOLD5 function does not 
support this option.

The Verification (defect management) function is standard 
on DVD-RAM drives, so there is no checkbox. Some 
drives do not allow you to disable this function.

Supported Drives (as at January 2003)

HL_DT_ST: GMA-4020B
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DVD-RAM Disc Write Protect Function

Note • Under Windows 2000, if you recorded with the Verification option disabled onto a DVD-
RAM disc that was not logically formatted before recording, it takes time to check the 
disc after recording.

• You require a drive that supports disabling the Verification function to set this option. 
Refer to the following table for more details on the B's Recorder GOLD5 functions that 
support this option.

Supported Functions Non-supported Functions

Recording by adding files/folders into the fields
Recording a data DVD using the Wizard
AutoPlay CD 
HDD Backup

Copying from DVD-RAM to DVD-RAM
Recording using an image file

❖ Lock (Write Protect) and Unlock a Disc
DVD-RAM discs have a write protect function that can 
be locked/unlocked using writing software, including 
B’s Recorder GOLD5 and the DVD-RAM driver.

Click this button on the Disc Information window to 
lock and unlock the disc.

[Protected] appears to the left of the lock when the 
disc is locked. You cannot record additional data onto 
the disc while it is locked. To unlock a disc, insert the 
locked disc, then click the lock on the Disc Information 
window.
14



DiscT@2 Function

DiscT@2 Settings
This function draws (basically burns) label information 
and images onto the unused space on the recorded side 
of a DAO CD-R or a closed CD-R.

❖ No DiscT@2
Nothing is drawn in the unused space of the disc.

❖ Text
Input a name with a maximum of 24 characters. Click 
the [A] button on the right of this field to set the font 
style and size. This will be drawn on all the unused 
space of the disc.

❖ Bitmap file
Click the button to the right of the field to specify a bit-
map file (*.bmp) to be drawn onto the disc. If the bit-
map is smaller than the unused space, the bitmap is 
tiled when drawn on the unused space.

Supported Drives (as at January 2003)

YAMAHA: CRW-F1E, CRW-F1S

Note The DiscT@2 function is valid when
• the DiscT@2 supported drive is properly recognized by B’s Recorder GOLD,
• the disc being recorded is a CD-R disc (CD-RW discs are NOT supported), and

When using the above settings, be sure you have either the [Disc-At-Once] or the [Close 
CD] option enabled when recording the disc. (You cannot draw onto an open TAO disc with 
the DiscT@2 function.)

You can also edit the image and text to be drawn onto the disc with the DiscT@2 Editor. 
Select [Tool] → [DiscT@2] to open the DiscT@2 Editor. See p. 27 for more details on using 
the editor.
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The recording mode when recording DDCD-R/RW discs is automatically set to Mode 2 form 1 TAO.

Supported Drives (as at January 2003)

SONY: CRX200E

Tip Suspend Recording: [Ctrl] + [S]
You can suspend recording by pressing the [Ctrl] + [S] keys when the BURN-Proof, 
JustLink or buffer underrun prevention functions are enabled.

Info BURN-Proof (BURN (Buffer Under RuN) -Proof)
This is the revolutionary technology developed by Sanyo which can prevent buffer under-
run errors.

JustLink
This is the revolutionary technology developed by Ricoh which can prevent buffer underrun 
errors.

JustSpeed
This is the new technology developed by Ricoh which adjusts the drive's recording speed 
to one suitable for the disc being recorded onto when the recording speed is set to 16x or 
faster.

DVD+RW
Developed in cooperation by 8 major drive makers as a DVD Alliance, it is the only rewrit-
able format that provides full, non-cartridge, compatibility with existing DVD-Video players 
and DVD-ROM drives for both real-time video recording and random data recording across 
PC and entertainment applications. DVD+RW is not compatible with DVD-RW or DVD-
RAM. See p. 19 for more details on DVD+RW support.

3 DDCD Support

Info DD (Double Density) CD
The disc capacity is 1.3GB; double that of a standard CD-R/RW.
It inherits the basic specifications of the CD formats.
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You can record files and folders as a DVD-ROM disc with a DVD-R/RW drive. You can also create 
DVD-Video discs using an image file (VIDEO_TS/AUDIO_TS directories) edited with authoring software.

* Some DVD players are not compatible with playing the created DVD-Video discs.

Supported Drives (as at January 2003)

Pioneer: DVD-RW DVR-103, DVD-RW DVR-104, DVD-RW DVR-105, DVD-RW DVR-K11
MATSHITA: LF-D521, SW-9571, SW-9581,  SW-9581N, UJ-810, UJ-811, DVD-RAM UJ-811, UJ-815, 

DVD-RAM LF-P567
DVD-R support only: LF-D310, SW-9501

GENERIC: DVD-RAM MLT01
HL_DT_ST: GMA-4020B
SAMSUNG: DVD-MULTI SRT03B
TOSHIBA: SD-R5002
SONY: DRU-500A, DW-U10A, DW-U12A
TEAC: DV-W50E
NEC: DVD_RW ND-1200A, DVD_RW ND-1300A, DVD-RW ND-1300M
TDK: DVDRW0400N

Points to Keep in Mind
DVD-R and DVD-RW Drives
• The file size is limited to a maximum of 2 GB for DVD-Video and 4 GB for DVD-R/RW as specified 

by the DVD format.
• DVD-R/RW discs support multi-border, so you can record additional data onto these discs. There 

are no OS restrictions when recording additional data.
• You cannot copy DVD-Video or copyright-protected DVDs. 
• If an error occurs in recording the image file while ripping or recording DVD data because of the file 

system limitation (2 GB in FAT 16, 4 GB in FAT 32), record the data using On-the-Fly.
• You cannot copy discs when the original disc format is different to the blank disc you will record.
• You require the same amount of free space in your work folder as the capacity of the disc to create 

an image file. (5 GB or more recommended.)
• The reading speed for DVD discs is always set to the fastest speed.
• DVD uses the terms "border" and "zone" where CD uses "session" and "track", respectively.
• Recording onto DVD-R/RW discs is 8x faster than CD-R/RW discs, e.g. DVD: 1x = CD: 8x, DVD: 2x 

= CD: 16x.

4 DVD-R/RW Support

Note Unsupported Functions
• Direct Cut
• Disc Rescue
17



DVD-R Drives
• DVD-R discs recorded in multi-session can only be read under Windows 2000 (SP3 or later) and 

Windows XP with a drive that supports DVD-R multi-border.
• The maximum number of borders you can record onto a disc is 99.
• The prompt on the right appears when recording onto a DVD-R disc if it is a blank disc, or you have 

not enabled [Disc-At-Once] or [Close CD].

■ Do not close the disc after recording
Records the data onto the disc in multi-border. You can record additional data onto the disc 
later, but the disc can only be read under Windows 2000 (SP3 or later) and Windows XP with a 
drive that supports DVD-R multi-border.

■ Prioritize compatibility and close the disc after recording
You cannot record additional data on the disc after this border. Select this option to increase the 
disc’s compatibility if you want the recorded disc to be read under various platforms.

DVD-RW Drives
• You cannot close a DVD-RW disc that was recorded with the [Do not close the disc after recording] 

option enabled. You can record additional data onto the disc until there is no more space available.
• You cannot record additional data onto a DVD-RW disc formatted with B's CLiP, and vice versa. 
• The following prompt appears when recording onto a DVD-RW disc if it is a blank disc, or you have 

not enabled [Disc-At-Once] or [Close CD].

■ Do not close the disc after recording
Records the data onto the disc in multi-border. You can record additional data onto the disc 
later.

■ Prioritize compatibility and close the disc after recording
You cannot record additional data on the disc after this border. Select this option to increase the 
disc’s compatibility if you want the recorded disc to be read under various platforms.
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You can record files and folders as a DVD-ROM disc with a DVD+RW/+R drive, and record additional 
file and folders onto the disc. You can also create DVD-Video discs using an image file (VIDEO_TS/
AUDIO_TS directories) edited with authoring software.

* Some DVD players are not compatible with playing the created DVD-Video discs.

Supported Drives (as at January 2003)

RICOH: DVD+RW MP5120/MP5125, DVD+RW RW5120/RW5125
HP: DVD Writer 100j, DVD Writer 200j, DVD Writer 300n
SONY: DVD+RW DRU-120A, DRU-500A, DW-U10A, DW-U12A
PHILIPS: DVD+RW-D01, DVD+RW-D02, DVDRW1208, DVDRW228, DVD6001, DVD6002, 

DVD+RW-D28
RIDATA: DVD+RW/+R DRIVE, DVD+RW DRIVE 
AOpen: DVRW2412PRO, 2.4X2.4X8 121032
IDE-DVD: DVDRW6001, DVDRW6002
Memorex: DVD+R/RW 2.4X8AA
NEC: DVD_RW ND-1200A, DVD_RW ND-1300A, DVD+RW ND-1000A, DVD+RW ND-1100A
TDK: DVDRW420N, DVDRW0400N
PLEXTOR: DVDR PX-504A

Points to Keep in Mind
DVD+RW and DVD+R Drives
• DVD-R/RW drives and DVD-R/RW discs are incompatible with the DVD+RW/+R format. You 

require both a DVD+RW/+R drive and DVD+RW/+R discs to use this format.
• You cannot select the simulation options in [Recording Method] when recording.
• You cannot copy discs when the original disc format is different to the blank disc you will record. 

(See the following table.)

• You cannot copy DVD-Video or copyright-protected DVDs. 
• You cannot record or copy onto a DVD-R/RW disc formatted with B's CliP. 
• You cannot copy a packet-written DVD.
• If an error occurs in recording the image file while ripping or recording DVD data because of the file 

system limitation (2 GB in FAT 16, 4 GB in FAT 32), record the data using On-the-Fly
• You can record UDF/UDF Bridge images only.
• The file size is limited to a maximum of 2 GB for DVD-Video and 4 GB for DVD+R/+RW as 

specified by the DVD format.
• You require the same amount of free space in your work folder as the capacity of the disc to create 

an image file. (5 GB or more recommended.)
• The reading speed for DVD discs is always set to the fastest speed.

5 DVD+RW/+R Support

Note Unsupported Functions
• Direct Cut
• Disc Rescue

Original Blank Disc Status

DVD CD-R/RW No

CD DVD+RW/+R No

DVD DVD+RW/+R Yes
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• DVD+RW/+R uses the term "zone" where CD uses "fragment".

DVD+RW Drives
• You cannot close a DVD+RW disc, so you can record additional data onto the disc until there is no 

more free space.

DVD+R Drives
• DVD+R discs recorded in multi-border using B’s Recorder GOLD5 ver. 5.24 or later are not com-

patible with DVD+R discs recorded in multi-border using ver. 5.23 or earlier. If you record additional 
data onto a DVD+R disc that was recorded in multi-border using ver. 5.23 or earlier, you can only 
view the data in the first session.

• Multi-session recording onto DVD+R discs is supported under all platforms (OS).
• DVD+R discs recorded in multi-session can only be read under Windows 2000 (SP3 or later) and 

Windows XP with a drive that supports DVD+R discs.
• The maximum number of sessions you can record onto a disc is 99.
• Only DVD+R discs can be used to copy DVD+R discs recorded in multi-session.
• The following prompt appears when recording onto a DVD+R disc if it is a blank disc, or you have 

not enabled [Disc-At-Once] or [Close CD].

■ Make additional recording
Records the data onto the disc in multi-session. You can record additional data onto the disc 
later, but the disc can only be read under Windows 2000 (SP3 or later) and Windows XP with a 
drive that supports DVD+R discs.

■ Prioritize compatibility and close the disc after recording
You cannot record additional data on the disc after this session. Select this option to increase 
the disc’s compatibility if you want the recorded disc to be read under various platforms.
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You can record files and folders as a DVD-ROM disc with a DVD-RAM drive, and record additional file 
and folders onto the disc

Supported Drives (as at January 2003)

Supported Drives that support the Verification option
MATSHITA: SW-9571, SW-9581, SW-9581N, LF-D521, LF-D310, UJ-810, DVD-RAM UJ-811, DVD-

RAM LF-P567, UJ-815
GENERIC: DVD-RAM MLT01
SAMSUNG: DVD-MULTI SRT03B

Supported Drives that do not support the Verification option
HL_DT_ST: GMA-4020B

Points to Keep in Mind
• You require both DVD-RAM drives and DVD-RAM discs to use this format.
• 2.6 GB DVD-RAM discs are not supported.
• You need to log on using an Administrator account under Windows 2000 to use this function.
• There are no simulation and [Record Speed] settings when recording onto a DVD-RAM.
• When installing the [DVD-RAM Driver] supplied with the DVD-RAM drive on a Windows OS earlier 

than Windows XP, two drive letters are allocated to one DVD-RAM drive; read drive and record 
drive. Both the [CD-ROM Drive] and the [Removable Drive] drives are mounted in My Computer. 
Refer to the following table for guidelines to reading and recording DVD-RAM discs with B's 
Recorder GOLD5. When copying DVD discs, select the drive letter for each the read drive and the 
record drive. If you insert an unsupported disc into the read or record drive, the disc may not be rec-
ognized and may be ejected as soon it is inserted.

• Do not launch B's Recorder GOLD5 while you are copying files on the Explorer.

6 DVD-RAM Support

Note Unsupported Functions
• Direct Cut
• Disc Rescue

DVD-RAM Driver
The DVD-RAM drive you purchased may not have come with a DVD-RAM driver. If so, be 
sure to read the points below regarding use of the drive without a DVD-RAM driver.

RAM Driver No. & Type of Drive Mounted Drive Functions

No
1 drive Supports read and record

Yes (Windows XP)
1 drive Supports read and record

Yes (Earlier than 
Windows XP)

1 DVD-RAM drive Used to read and record DVD-RAM

1 DVD-RAM drive Used to read and record other discs
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• You cannot use the DVD-RAM driver to record onto a disc recorded onto using B's Recorder 
GOLD5. You must physically format the disc (erase the entire disc) before recording onto it using 
the DVD-RAM driver. Refer to the following table for details on software and recording additional 
data.

• The DVD-RAM verification function differs to other recordable DVD discs. If a verification error 
occurs, the defect sector is automatically voided and the data is assigned to a substitute sector. 
This function realizes high-quality, reliable recording, but enabling it doubles the recording time. 
You require a drive that supports disabling this function to record without it.

• The disc is checked when you begin recording with the Verification option disabled. If it is deter-
mined that it is unsuitable to record on the disc with the Verificiation option disabled, recording will 
continue with this option enabled.

• Under Windows 2000, if you recorded with the Verification option disabled onto a DVD-RAM disc 
that was not logically formatted before recording, it takes time to check the disc after recording.

• Buffer underrun errors do not occur on DVD-RAM drives, so it is recommended you record using 
On-the-Fly for faster recording.

• The maximum time required to physically format a disc is one and a half hours depending on the 
drive and the disc.

• You cannot close the disc, so you can record onto it until there is no free space remaining.
• The file size is limited to a maximum of 4 GB for DVD-RAM as specified by the DVD format.
• The reading speed for a DVD is always set to the fastest speed.
• You cannot copy a multi-border or packet-written DVD.
• You cannot copy discs when the original disc format is different to the blank disc you will record. 

(See the following table.)

• You can copy a DVD-RAM when the total capacity of the disc onto which you will copy is greater 
than the capacity of the original DVD-RAM disc. You cannot copy DVD-Video or copyright-pro-
tected DVDs.

• DVD uses the terms "border" and "zone" where CD uses "session" and "track", respectively.

Record Method Record Format
Additional Recording

GOLD5 DVD-RAM Driver Windows XP

GOLD5 UDF1.02 Yes No No

DVD-RAM Driver
FAT32, UDF1.5, 
UDF2.0

No Yes FAT32 only

Windows XP FAT32 No No Yes

Original Blank Disc Status

DVD-ROM CD-R/RW No

CD-ROM DVD-RAM No

DVD-RAM DVD-RAM Yes

DVD-ROM DVD-RAM Yes

DVD-RAM DVD-R No
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A DVD disc are the same size as a 12cm CD, but also has the capacity to hold large volumes of data 
that are read or written by lasers onto the pits on the disc surface. Whereas CDs can only be written on 
one side, DVDs can be written on both sides. The pits are denser than CD pits allowing a double-sided, 
double-layer DVD to store up to 17 GB of data.

There are several formats or books of DVD. DVD-Video is the read-only format for the interactive play-
back of high quality video on household DVD players. There are also DVD-ROM and DVD-RAM for use 
on computers, write-once DVD-R, and rewritable DVD-RW/+RW. Even though there is a format to suit 
your every need, not all drives support the various formats.

DVD discs have been known in the past as "Digital Versatile Discs" or "Digital Video Discs", but they are 
now more commonly referred to as DVD.

DVD Formats

❖ DVD-R
The write-once DVD format that is used for authoring and DVD players. It originally could only store 
3.95 GB on one side, but was extended to 4.7 GB on one side in line with DVD-ROM and DVD 
Video in 2000. At the same time, the format was split into "authoring" and "general" versions with 
different laser wavelengths for each version. "DVD-R for General" is intended of mass distribution 
and includes copy protection codes in the drives and the disc. "DVD-R for Authoring" is intended for 
professional authoring use and the copy protection codes are included in the drives only.

❖ DVD-RAM
A rewritable DVD has the single-sided capacity of 4.7 GB or double-sided capacity of 9.4 GB, and 
can be rewritten more than 100,000 times. This format is most commonly used in computers. DVD-
RAM compatible drives are required to read DVD-RAM discs.

❖ DVD-ROM
A read-only DVD used for storing data and for distributing software. It has a single-side capacity of 
4.7 GB (single layer) and 8.5 GB (double layer), and a double-sided capacity of 9.4 GB (single 
layer) and 17 GB (double layer).

❖ DVD-RW
DVD-RW is a phase-change erasable disc with a read-write capacity of 4.7 GB that can be rewrit-
ten about 1,000 times. DVD-RW discs are compatible with most DVD players and DVD-ROM 
drives.

❖ DVD+RW
The DVD-RW format was defined and developed with the cooperation of 8 major drive makers 
(Hewlett-Packard, Mitsubishi Chemical, Philips, Ricoh, Sony and Yamaha) as a DVD Alliance. It is 
a phase-change erasable disc rewritable format that provides full compatibility with DVD-Video 
players and DVD-ROM drives. It has a single-sided capacity of 4.7 GB.

7 What is DVD?

Info UDF (Universal Disk Format) Bridge
UDF Bridge allows you to access data written in both 
UDF (the DVD file system structure) and ISO9660 (the 
CD-ROM file system structure).

Copying Multi-border/Multisession Discs
Refer to the following tables to check whether you can copy a DVD multi-border or DVD 
multisession disc or not.

FileUDF Bridge

ISO9660

UDF

File
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Table 1: Copy Status of DVD-R/RW Discs

Original Format Blank Disc Copy Status

DVD-R

Single Border

DVD-R Yes

DVD-RW Yes

DVD+RW Yes

DVD+R Yes

DVD-RAM Yes

Multi-border

DVD-R Yes

DVD-RW No

DVD+RW No

DVD+R No

DVD-RAM No

DVD-RW Single Border

DVD-R Yes

DVD-RW Yes

DVD+RW Yes

DVD+R Yes

DVD-RAM Yes

Table 2: Copy Status of DVD+RW/R & DVD-RAM Discs

Original Format Blank Disc Copy Status

DVD+R

Single Border

DVD-R Yes

DVD-RW Yes

DVD+RW Yes

DVD+R Yes

DVD-RAM Yes

Multi-border

DVD-R No

DVD-RW No

DVD+RW Yes

DVD+R No

DVD-RAM No

DVD+RW Single Border

DVD-R Yes

DVD-RW Yes

DVD+RW Yes

DVD+R Yes

DVD-RAM Yes

DVD-RAM Single Border

DVD-R No

DVD-R No

DVD+RW No

DVD+R No

DVD-RAM Yes
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Audio Master and Advanced Audio Master allow you to create high-quality audio and data CDs. You 
can also record additional audio tracks onto a CD-RW in TAO.

Supported Drives (as at January 2003)

Drives that support Audio Master
YAMAHA: CRW3200E, CRW3200S

CRW2200E (Firmware 1.0e or later)
CRW2200S (Firmware 1.0e or later)
CRW-70 (Firmware 1.0e or later)

Drives that support Advanced Audio Master
YAMAHA: CRW-F1E, CRW-F1S

❖ Audio Master & Advanced Audio Master
The Audio Master or Advanced Audio Master setting is found on the Recording window.

8 Audio Master & Advance Audio Master Support

Audio CD Data CD

Info The Advanced Audio Master logo appears at the bot-
tom of the settings window for drives that support this 
function.
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❖ Recording Additional Audio Tracks
This function is valid on CD-RW discs that have audio tracks recorded in TAO.
Insert the disc into the drive. Select [Audio Appendable CD-RW] from the [Tool] menu. You can 
delete existing tracks and add new tracks in the following window.

[Delete last track]
Click this button to delete the last track on the [Current] list one by one.

[Undo]
Click this button to undo all the new settings and revert to the disc's original status.

[Record]
Click this button to record all the settings in under [New track] and [Current] onto the CD-RW disc. 

[Close]
Click this button to cancel all the settings you made and return to the B's Recorder GOLD5 main 
window.

[Add]
Click this button to add new tracks. You can drag and drop the tracks to the [New track] list.

[Delete]
Click this button to delete the tracks selected under [New track].

[Delete all]
Click this button to delete all the tracks under [New track].

Note Audio Master Restrictions
• The buffer underrun prevention function is invalid.
• The recording speed is always set to 4x for Audio Master, and 1x,�� and 8x for 

Advanced Audio Master.
• When using an USB 1.1 connection, select a recording speed of 4x or slower.
• The recording type is always set to DAO.
• The capacity for a 650 MB disc is 63 mins; a 700 MB disc is 68mins.

Info Audio Master & Advanced Audio Master
The Audio Master and Advanced Audio Master functions achieve high quality sound 
recording with a minimum of noise and less jitter by making the recorded pits and lands 
longer than normal and increasing the linear speed during recording.

Drag the tracks to change 
their play order under [New 
Track]. Any new tracks 
added will be recorded after 
the existing tracks.
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The DiscT@2 function draws (basically burns) text and images onto the unused space on the recording 
side of a closed CD-R disc.

Using the DiscT@2 Editor

1. Launch B’s Recorder GOLD5, then insert the CD-R disc to be drawn into the drive.

2. Select [Tool] → [DiscT@2] from the menu.

3. The unused space onto which you can draw using the DiscT@2 function is shown by a dot-
ted line on the DiscT@2 Editor window.

4. Design or edit the DiscT@2 content using the font, draw and capture tools.

5. Once you have finished editing the content, click [Draw] in the bottom right of the window.

6. A preview is displayed. Click [OK] to begin drawing the DiscT@2 onto the disc

7. You can save the edited content by selecting [File] → [Save].

9 DiscT@2 Editor

Font, draw and capture 
tools

[Draw] button

Note The DiscT@2 function is valid when
• the DiscT@2 supported drive is properly recognized by B’s Recorder GOLD,
• the disc being recorded is a CD-R disc (CD-RW discs are NOT supported), and
• the [Disc-At-Once] or the [Close CD] option is enabled when recording the disc. 

(You cannot draw onto an unclosed TAO disc with the DiscT@2 function.)
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You can take advantage of the following functions in B's Recorder GOLD5 with the MP3 Encoder.

❖ Create an audio CD from MP3 files
Add the MP3 file to the project as is and record directly onto a disc to create an audio CD.
Supported MP3 file format:

44100Hz/22050Hz/11025Hz/Stereo
Layer-3/VBR supported

❖ MP3 Encoding Function
Full MP3 (IIS) encoding functionality.
Supported MP3 file format:

44100Hz/Stereo
96/112/128/160/192/224/256/320kbps/VBR
Note: There is no limit on the use of the MP3 (ACM) encoding function.

❖ Video CD PBC Function
You can create one Video CD 2.0 Play Back Control (PBC) compatible menu using a pre-prepared 
bitmap when creating a video CD from MPEG1 files.

10 MP3 Encoder

Note The Basic and bundled versions of B's Recorder GOLD5 have a 30-day limit or a 20-
conversion limit on the use of the MP3 Encoder. See below for details on purchasing the 
Encoder Key to unlock these limitations.

Tip Choosing an MP3 Encoding Engine
If you have multiple encoding MP3 
engines, you can select the engine 
used to create the MP3 files.

Info ACM (Audio Compression Manager)
This is the standard built-in CODEC for the Windows audio functions. Install Microsoft Net-
show to use the MP3 Audio CODEC. The files are encoded to AM radio broadcast quality.

IIS
IIS is the Fraunhofer IIS MPEG Layer-3 CODEC that produces higher quality MP3 files 
than ACM. It is used as the B's Recorder GOLD5 standard MP3 encoding engine.
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❖ Unlocking the Encoder
Input the Key Code you purchased into the MP3 Encoder Information window, then click [Unlock]. 
The [MP3 Encoder Information] item no longer appears in the [Help] menu.

❖ Where to purchase the Encoder Key
http://www.bhacorp.com/shop/

❖ MP3 Licence
MPEG Layer-3 audio compression technology licenced by Fraunhofer IIS and THOMSON multimedia

Input the Encoder Key here.

Tip Displaying the MP3 Encoder Information Window
If the MP3 Encoder has a limit, select [MP3 Encoder Information] from the [Help] menu to 
display the following window.

B's Recorder GOLD5 Drive Guide
B.H.A Corporation
30 January 2003 13th Edition
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